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 Computer— Hardware Components

Tech Trivia Section A (Objective)

A.	 1.	 c	 2.	 b	 3.	 c	 4.	 b	 5.	 b	 6.	 a
B.	 1.		 Control Unit (CU) 
	 2.	 Pen Drives
	 3.	 Graphics cards, Sound cards
	 4.	 Modem
	 5.	 LaCie SAFF Hard Drive
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 T	 5.	 F

Answer Arcade Section B (Subjective)

A.	 1.	� The SMPS manages the computer’s power supply. It converts Alternating Current (AC) from 
a power source into low-voltage Direct Current (DC) to supply to other computer parts. 

	 2.	� (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question 2. Name two types of modems.
		  Answer. The two types of modems are: internal modems and external modems.
	 3.	� A scanner is a device that inputs printed pictures and text into the computer by digitising 

them.
	 4.	� A 3D camera is a real-sense device capable of recognising faces for logging into devices 

like smartphones and laptops. Additionally, 3D cameras can measure distances between 
objects and scan items for 3D printing.

	 5.	� A CD-R allows users to write data only once, which cannot be altered or erased. Whether 
a CD-RW can be used repeatedly to write, erase, and modify data as needed.

B.	 1.	� The CPU has three main parts: 
	 	 ●	 Arithmetic Logic Unit (ALU): It performs all mathematical and logical operations. 

1.
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	 	 ●	 Control Unit (CU): It manages and directs the processor’s operations. 
	 	 ●	 Memory Unit (MU): It stores data and instructions.
	 2.	� Internal hardware components are located inside the CPU box\cabinet. Examples include 

the CPU, Motherboard, Switched-Mode Power Supply (SMPS), Disk Drives, Modem, Ports, 
etc.

		�  External hardware components, also known as peripheral devices, are devices located 
outside the CPU box/cabinet. These devices connect to the computer through ports or 
wirelessly. Examples include the Keyboard, Mouse, Scanner, Webcam, etc.

	 3.	� The CD drive reads data stored on a compact disc (CD), an external storage device with a 
longer lifespan than magnetic disks. CDs can hold up to 700 MB of data. Types of CDs:

	 	 ●	 �CD-ROM (Compact Disc Read-Only Memory): A CD-ROM contains data that is written 
during manufacturing and cannot be modified or erased. 

	 	 ●	 �CD-R (Compact Disc Recordable): A CD-R allows users to write data only once, which 
cannot be altered or erased. 

	 	 ●	 �CD-RW (Compact Disc Rewritable): A CD-RW can be used repeatedly to write, erase, 
and modify data as needed.

	 4.	� A Blu-ray disc is an optical storage medium designed for holding large amounts of data and 
playing high-definition videos. It differs from DVDs primarily in its much greater storage 
capacity.

	 5.	� Portable printers are small and easy to carry, making them ideal for printing documents, 
photos, or labels wherever you go. They connect to devices like phones or laptops using 
USB, Bluetooth, or Wi-Fi. These printers use Zero Ink (Zink) technology, which means they 
don’t require traditional ink. Instead, they use special paper with built-in colour crystals 
that are activated by heat. 

C.	 �1.	 Riya should use scanner to achieve this.
	 2.	 Portable printers.

Higher Order Thinking Skills (HOTS)
1.	� Internal and external hardware components are both essential to the functioning of a computer, 

each serving distinct but interconnected purposes. 
2.	� A computer with only input devices but no output devices would face significant functional 

limitations, as output devices are critical for user interaction and feedback.

Code Clues

 Solve the puzzle.
	 1.		 VIRTUAL KEYBOARD
	 2.	 HARD DISK
	 3.	 SHEETFED SCANNER
	 4.	 ALU
	 5.	 PEN DRIVE
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Digital Drills

Do it yourself

 Number System

Tech Trivia Section A (Objective)

A.	 1.	 c	 2.	 b	 3.	 b	 4.	 b	 5.	 b
B.	 1.	 Binary	 2.	 LSD	 3.	 16	 4.	 2	 5.	 10
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 T	 5.	 T

Answer Arcade Section B (Subjective)

A.	 1.	 The total number of digits used in a number system is called its base or radix.	
	 2.	� Names of four types of number systems are: Decimal number system, Binary number 

system, Octal number system and Hexadecimal number system.
	 3.	� Computers use binary language, consisting of 0s and 1s, to represent the ON and OFF 

states of tiny components like transistors. All instructions are converted into this language 
for the computer to process and execute tasks.

	 4.	� The octal number system has a base of 8 and uses 8 digits: 0 to 7. Each place in an octal 
number represents a power of 8.

B.	 1.	� The decimal number system is a standard method for representing numbers using ten 
digits: 0 to 9. This system, with a base of 10, is the most widely used. For example, (217)10 
is a decimal number.

		�  The hexadecimal system has a base of 16 and uses 16 symbols: 0 to 9 and A to F. The 
letters A to F mean 10 to 15. Each place in a hexadecimal number represents a power of 
16. For example, (764)₁₆ is a hexadecimal number.

	 2.	� In Decimal number system, each digit’s value depends on its position and weight. The 
rightmost digit has the lowest weight and is called the Least Significant Digit (LSD), 
while the leftmost digit has the highest weight and is known as the Most Significant Digit 
(MSD). For example, in the number 724, the digit 7 is the MSD, and the digit 4 is the LSD.

	 3.	� In binary subtraction, the smaller binary number is subtracted from the larger one. The 
table below illustrates how to subtract digit Y from digit X. If Y is greater than X, we borrow 
1 from the next higher position. When a binary digit of 0 borrows 1, it effectively becomes 
2 (written as 10 in binary). 

2.
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		  The rules for subtracting two binary digits are given below:

		

X Y X – Y

0 0 0 – 0 = 0

0 1
0 – 1 = 1

(borrow 1, so that 10 – 1 = 1)

1 0 1 – 0 = 1

1 1 1 – 1 = 0

C.	 1.	 13
	 2.	 a.	 (1110)2	 		  b.	 (10010)2	 c.	 (11000)2	 d.	 (10111)2

	 3.	 (0100)2

	 4.	 a.	 (101101)2

	 	 b.	 (1011011)2

	 	 c.	 (11111010)2

	 	 d.	 (100101)2

	 	 e.	 (1011001)2

D.	 1.	� Computers use binary language, consisting of 0s and 1s, to represent the ON and OFF 
states of components like transistors. All instructions are converted into binary for the 
computer to process and execute tasks.

	 2.	� The hexadecimal system has a base of 16 and uses 16 symbols: 0 to 9 and A to F. The 
letters A to F mean 10 to 15.

Higher Order Thinking Skills (HOTS)
1.	� The decimal number system is commonly used in everyday life, but computers use the binary 

number system. Additionally, computers also utilise the octal and hexadecimal number systems.
2.	� Binary number system is the basic language that computers understand.
	 Hexadecimal helps make long binary numbers easier to read.

Code Clues

Answer the following questions with the help of the clues:
	 1.	 Bit	 2.	 Byte	 3.	 C	 4.	 Binary
	 5.	 Decimal number system

Tangible Task
Do it yourself
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 Computer Virus

Tech Trivia Section A (Objective)

A.	 1.	 b	 2.	 a	 3.	 b	 4.	 c	 5.	 b
B.	 1.	 Worm	 2.	 Boot Sector 			   3.	 Spyware 
	 4.	 Spyware 	 5.	 Ransomware 
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 F	 5.	 F

Answer Arcade Section B (Subjective)

A.	 1.	� A rootkit is malware that gains administrator access to the host system. Once access is    
gained, the rootkit hides but retains special access, making it hard to detect because it 
can bypass security software.  

	 2.	� Malware is a malicious program designed to damage or perform unwanted actions on a 
computer. Three types of malware are: 

		  i.   Worms - are a type of malware that replicates itself without human intervention.
		  ii.  �Trojan horse - is a type of malware that disguises itself as something harmless, like a 

game or a useful program.
		  iii. �Spyware-  is malware designed to secretly monitor a user’s activities and send the 

collected information to a hacker.
	 3.	 An infected computer may show the following signs:
		  i.   Loads programs more slowly. 
		  ii.  Takes longer to shut down.
	 4.	� Email virus spreads through infected email attachments or links. When opened, it can 

delete files, corrupt data, crash the system, and spread to contacts.
B.	 1.	� Program File Virus - A Program File Virus infects executable files such as .exe, .com, and 

.sys files. It activates when the infected file is executed and can spread to other files, 
making them unusable. This virus remains in the system memory and can affect multiple 
programs.

		  Examples: Jerusalem, Cascade
		�  Macro Virus - A Macro Virus infects documents that use macros, such as Microsoft Word 

and Excel files. It spreads when an infected document is opened and can automatically 
attach itself to other documents, sometimes even spreading via email.

		  Examples: Melissa, Bablas
	 2.	 Preventive measures to protect your computer from viruses are:
		  ●	 Download only legal software from trusted sources. 

3.
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		  ●	 Avoid opening emails from unknown senders. 
		  ●	 Don’t open email attachments unless you know the sender. 
		  ●	 Don’t download music, programs, or games from unfamiliar websites. 
		  ●	 Install and use antivirus software on your computer.
		  Antivirus software works as:
		  ●	 Scans files and programs for malicious code.
		  ●	 Detects and removes viruses by comparing files against a virus database.
		  ●	 Quarantines infected files to prevent further spread.
		  ●	 Regularly updates virus definitions to detect new threats.
	 3.	 An infected computer may show the following signs:
		  ●	 Display unusual messages on the screen. 
		  ●	 Load programs more slowly. 
		  ●	 Take longer to shut down. 
		  ●	 Increase the size of infected files. 
		  ●	 Automatically change file names or types.
	 4.	� A firewall is a security system that monitors and controls network traffic based on predefined 

rules. It acts as a barrier between a secure internal network and an external, less trusted 
network, such as the Internet. A firewall helps prevent unauthorised access, blocks malware 
attacks, and restricts access to unsafe websites. It examines each data packet and decides 
whether to allow or block it. Firewalls can be software-based (installed on a computer) or 
hardware-based (used to secure a network). They are essential for protecting systems and 
preventing cyber threats.

C.	 1.	� Rohit should not open the attachment immediately. He must check the sender’s details, 
scan the attachment with antivirus software, and look for suspicious signs in the email. If 
the email seems unsafe, he should delete it to prevent malware infections.

	 2.	� Rahul should scan his computer with antivirus software, check for unusual programs, and 
remove unfamiliar software. Spyware can steal personal data, monitor online activities, 
and compromise security, leading to privacy risks and identity theft.

Higher Order Thinking Skills (HOTS)
	�  1.	� I would scan the computer with antivirus software, check for unusual programs, and monitor 

system performance. If a virus is detected, I would remove or quarantine the infected files 
and delete the suspicious download. Restarting the system and updating security software 
can help fix the issue.

	 2.	� Updating antivirus software ensures protection against new viruses and malware. Without 
updates, the system becomes vulnerable to cyber threats, increasing the risk of data loss, 
identity theft, and system damage.
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Code Clues

Find the words related to virus in the grid.

Digital Drills

Do it yourself

 Ethics and Safety Measures in Computing

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 a	 3.	 d	 4.	 b	 5.	 b
B.	 1.	 Network of Networks	 2.	 Newsgroups, Blogs	 3.	 Cybercrime
	 4.	 Hacking			   5.	 Trademark
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 F	 5.	 T

Answer Arcade Section B (Subjective)

A.	 1.	� A digital footprint is the trace or marks left behind when someone uses the Internet. 
Activities such as sending emails, sharing attachments, and uploading videos or images 
create a record of personal information accessible online. This is also known as a digital 
dossier.

	 2.	� Phishing is a type of cybercrime where a fraudulent email pretends to come from a trusted 
organisation. These emails usually contain a link to a fake website that prompts users to 
enter sensitive information such as credit card details, passwords, and usernames.

4.
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	 3.	� Computer Ethics are guidelines for using computers responsibly and wisely. They are also 
known as Etiquettes and are becoming increasingly important due to rising issues like 
cybercrime, software piracy, unauthorised access, spamming, and hacking.

	 4.	� Spam refers to unwanted e-mails sent by companies to promote their products, often in 
bulk. These e-mails, also known as bulk e-mails, can clutter your inbox and may even carry 
viruses, worms, or be used for cyber-attacks.

B.	 1.	 Two advantages of the Internet are:
		  i.	� Treasure of Information: The Internet is a vast source of information. You can search 

for and access information on virtually any topic, making it a valuable tool for projects 
and research. 

		  ii.	� Web Services: The Internet offers many useful services, such as chat, email, video 
conferencing, etc., which help people connect globally. These services also allow 
organisations to exchange information efficiently and hold meetings with employees 
in different locations.

	 2.	 Four safety measures for protecting privacy online are: 
		  i.	 Avoid entering your personal information on every website. 
		  ii.	 Enable Private Browsing to keep your browsing history confidential.  
		  iii.	 Opt for cash on delivery instead of card payments for online purchases. 
		  iv.	 Never share your credit card PIN with others to prevent potential misuse.
	 3.	 The following measures can help safeguard your intellectual property rights:
		  i.	 Keep your business ideas confidential and do not share them with others. 
		  ii.	� Maintain detailed records, including drawings, descriptions, and plans, to prove 

ownership of your creations. 
		  iii.	� Register your business name and logo as trademarks as soon as you have them to 

secure your rights.
C.	 1.	 Plagiarism – presenting someone else’s work as his own.
	 2.	 Phishing. She should not click links, verify the sender, and contact the bank directly.

Higher Order Thinking Skills (HOTS)
	 1.	� They are created through online activities. Reduce them by deleting history, adjusting 

privacy settings, and using strong passwords.
	 2.	 Very effective. It adds extra security and prevents unauthorised access.

Code Clues

Solve the puzzle.
	 Across
	 2.	 IPR 
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	 4.	 SOFTWAREPIRACY
	 5.	 HACKING
	 Down
	 1.	 CYBERBULLYING
	 3.	 SPAM 

Tangible Task
Do it yourself

Digital Drills

Do it yourself

 Spreadsheets—An Introduction

Tech Trivia Section A (Objective)

A.	 1.	 b	 2.	 b	 3.	 b	 4.	 b	 5.	 b
B.	 1.	 Active Cell	 2.	 Status Bar	 3.	 Workbook	 4.	 Address	 5.	 Mouse Pointer
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T

Answer Arcade Section B (Subjective)

A.	 1.	 Formatting features are used to enhance the appearance of the data.
	 2.	 Click on the cell where you want to enter the data and start typing.	
	 3.	 File tab opens the Backstage View for tasks like New, Open, Save, Print, etc.
	 4.	� Quick Access toolbar is a customisable toolbar at the top of the window for easy access 

to frequently used commands like Save, Undo, and Redo, without needing to remember 
shortcut keys.

B.	 1.	 To create a new workbook, follow the given steps:
		  i.	 Click on the File tab.
		  ii.	 Click on the New option.
		  iii.	 Click on the Blank workbook.    
		  A new workbook will be created.

5.
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	 2.	� After finishing your work in Excel, it’s important to save it to avoid data loss. Save updates 
the existing file, while Save As lets you save it with a new name or location. The first time 
you save, both options work the same. Regular saving helps protect your data. It also 
ensures that all your latest changes are not lost.

	 3.	 Two types of data that can be entered in Excel are:
		  i.	� Numbers: Numbers include the digits (0–9) and their various combinations. All types 

of calculations can be done on numbers. By default, Excel aligns numbers to the right. 
		  ii.	� Text: Text includes the collection of letters, numbers, and special characters. No 

mathematical calculation can be performed on text. By default, Excel aligns text to the 
left.

C.	  1.	� Amit should use text for student names, numbers for total days, and dates for attendance 
records.

	 2.	� Aisha should click the cell, then click the Formula Bar, type the formula starting with =, 
and press Enter.

Higher Order Thinking Skills (HOTS)
	� 1.	� Auto Fill saves time, reduces errors, and helps in quickly entering data in a series, improving 

efficiency.
	 2.	� Using worksheet tab navigation buttons is most effective, as they help quickly move 

between sheets without scrolling manually.

Code Clues

Identify and label the parts of the Excel window accurately.

Ribbon

Title Bar

Formula 
Bar

Column Heading

Quick Access Toolbar

Worksheet Tabs

Worksheet Tab Nagivation Button

Cell

Active cell

Status Bar

Row  
Heading

Select All 
Button

Name Box

File Tab
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Digital Drills

Do it yourself

 More on Spreadsheets

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 d	 3.	 a	 4.	 c	 5.	 c	 6.	 d
B.	 1.	 Borders	 2.	 Merge & Center	 3.	 Parentheses	 4.	 Column
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 F	 5.	 F

Answer Arcade Section B (Subjective)

A.	 1.	� The Wrap Text feature automatically moves text to the next line within a cell, so the content 
is fully visible without being cut off.

	 2.	� Yes, you can undo multiple actions in Excel. The Undo command reverses recent actions 
sequentially. You can click the Undo button multiple times or use the Ctrl + Z shortcut 
repeatedly.

	 3.	� The Auto Fill feature in Excel allows you to quickly fill cells with repetitive or sequential 
data by dragging the fill handle (a small square at the bottom-right corner of a cell). It can 
extend patterns, fill series, copy formatting, and complete custom lists efficiently.

B.	 1.	� In Excel, the Copy and Paste feature allows you to duplicate data from one location to 
another without removing the original content. It is useful when you want to use the same 
data in multiple places. To copy and paste data using shortcut keys in Excel, first select the 
data you want to copy and press Ctrl + C on your keyboard. Then, click on the cell where 
you want to paste the copied content. Finally, press Ctrl + V to paste the data into the 
selected cell.

	 2.	 Steps to insert a row and a column in Excel
		  Inserting a row:
		  i.	 Select the row heading where you want to insert a new row.
		  ii.	 Click on the Home tab.
		  iii.	 Click on the Insert command.
		  iv.	 Select Insert Sheet Rows option.
		  A new row is inserted above the selected row, and the existing rows shift downward.

6.
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		  Inserting a column:
		  i.	 Select the column heading where you want to insert a new column.
		  ii.	 Click on the Home tab.
		  iii.	 Click on the Insert command.
		  iv.	 Select Insert Sheet Columns option.
	 3.	� Excel follows the BEDMAS rule to perform calculations in formulas. BEDMAS stands for 

Brackets, Exponents, Division, Multiplication, Addition, and Subtraction, and it defines the 
order in which operations are carried out in a formula.

		  For example, consider the formula:
		  =(8 + 5) – (2 + 3) ^ 2
		  i.	 First, Excel calculates the expressions inside the brackets: (8 + 5) = 13 and (2 + 3) = 5
		  ii.	 Next, it performs the exponentiation: 5 ^ 2 = 25
		  iii.	 Then it subtracts: 13 – 25 = –12
	 4.	� A Contiguous Cell Range is a group of cells that are next to each other. It is selected by 

clicking the first cell and dragging the mouse to the last cell, or by holding the Shift key 
and clicking the end cell. A colon (:) is used to define this range, for example: A1:A6.

		�  A Non-Contiguous Cell Range refers to cells that are not next to each other. To select them, 
hold down the Ctrl key and click each cell individually. A comma (,) is used to separate the 
cells in the range, for example: A1, B1, C3.

	 5.	 To format numbers in Excel, follow these steps:
		  i.	 Select the cell(s) containing the numerical data.
		  ii.	 Click the arrow next to the Number Format box in the Home tab.
		  iii.	 Click on More Number Formats to view detailed formatting options.
		  iv.	 Select the desired Number category (e.g., Currency, Percentage, Date, etc.).
		  v.	 Click the OK button to apply the formatting.
C.	  1.	� Aryan can use the Number Format feature. He should select the cells, click on the arrow 

next to the Number Format box, and choose the Currency option.
	 2.	 Maya can select the range A1 to A10 and press Alt + = to quickly insert the SUM formula.

Higher Order Thinking Skills (HOTS)
	� 1.	� Click the merged cell, go to the Home tab, click the arrow next to Merge & Center, and 

select Unmerge Cells. Then, manually adjust the content and formatting in the separated 
cells.

	 2.	� Enter the custom series (e.g., Monsoon, Winter), select the cells, then drag the Fill Handle 
to extend the pattern. Excel will repeat the sequence based on the selected pattern.
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Code Clues

Locate eight features of Excel in the grid.

Digital Drills

Do it yourself

Worksheet 1
(Based on chapters 1 to 6)

A.	 1.	 Compact Disc (CD) drives, Digital Versatile Disc (DVD) drives	  
	 2.	 Ethernet Port, Serial Port	  
	 3.	 Decimal number, Octal number
	 4.	 Macro Virus, E-mail Virus	  
	 5.	 Plagiarism, Cyberbullying
	 6.	 File tab, Ribbon
B.	 1.	� Hardware - All the physical parts of a computer system are known as hardware. These are 

the components you can see or touch.
	 2.	 Radix -  The total number of digits used in a number system is called its radix. 
	 3.	� Antivirus - Antivirus is a type of software designed to detect, remove, and prevent harmful 

programs (like viruses, worms, and spyware) from infecting your computer.
	 4.	� Cybercrime - Cybercrime refers to illegal activities conducted using computers or the 

Internet.
	 5.	 Cell range - A cell range is a collection of two or more cells.
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	 6.	� The Auto Fill feature in Excel allows you to quickly fill cells with repetitive or sequential 
data by dragging the fill handle, a small square at the bottom-right of a cell.

C.	 1.	 CPU (Central Processing Unit)
	 2.	 SMPS (Switched-Mode Power Supply)
	 3.	 Webcam
	 4.	 Byte
	 5.	 Virus
	 6.	 Digital Footprint
	 7.	 Title Bar
	 8.	 Equal Sign (=)
D.	 1.	 Projector
	 2.	 Graphic Tablet
	 3.	 The Switched Mode Power Supply (SMPS)

Test Sheet 1
(Based on chapters 1 to 6)

Section A
A.	 1.	 a	 2.	 a	 3.	 c	 4.	 b	 5.	 b
	 6.	 d	 7.	 c	 8.	 a
B.	 1.	 Input devices			   2.	 8	 3.	 Antivirus
	 4.	 Spam			   5.	 Formula	 6.	 Cell Style

Section B
A.	 1.	 Yes, both the mouse and keyboard can be wireless.
	 2.	 1 nibble = 4 bit.
	 3.	� Eradicating a virus means removing or deleting a computer virus using antivirus software 

to prevent damage to files and the system.
	 4.	� Cyberbullying is harassing, threatening, or insulting someone online through messages, 

social media, or emails.
	 5.	 An active cell is the currently selected cell in a worksheet, highlighted with a green border.
	 6.	� Yes, merged cells can be unmerged using the “Unmerge Cells” command under the Merge 

& Center option in the Home tab.
B.	 1.	� The Switched Mode Power Supply (SMPS), also called the power supply unit, manages 

the computer’s power supply. It converts Alternating Current (AC) from a power source 
into low-voltage Direct Current (DC) to supply to other computer parts. It has a switching 
regulator that controls the output voltage and has a built-in fan to help cool it down.
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	 2.	 To convert (1111) ₂ to a decimal number, follow these steps:
	 	 Step 1: Expand using positional values
		�  Each digit in the binary number represents a power of 2, starting from the right (least 

significant bit).
		  (1111)2= (1×23) +(1×22) +(1×21) +(1×20)
	 	 Step 2: Calculate powers
		  = (1×8) +(1×4) +(1×2) +(1×1)
		  =8+4+2+1
		  =15
		  (1111)2= (15)10 
	 3.	� A computer virus is a malicious piece of code or program designed to corrupt data or 

program files stored on a computer system. It infiltrates the system without the user’s 
knowledge or consent, often going undetected. Initially, viruses may only affect one 
computer, but if that computer is connected to a network, the virus can spread to other 
systems, much like a biological virus spreads between people. Once inside a computer, 
viruses disrupt normal operations, affecting resources like processing power, memory, and 
installed software. This can lead to a slowdown in performance or, in severe cases, cause 
irreversible damage to the hard drive. The acronym VIRUS stands for ‘Vital Information 
Resources Under Seize.

	 	 Two types of computer viruses are:
		  i.	 Program File Virus
		  ii.	 Boot Sector Virus
	 4.	� Plagiarism involves taking someone else’s work and presenting it as your own without giving 

proper credit. For example, if you download a PowerPoint presentation on cybercrime from 
the Internet and present it as your own work without citing the source, that is plagiarism.

	 	 Measures to Prevent Plagiarism:
		  i.	� Always acknowledge the source of your information. This process is known as citation 

and helps avoid plagiarism. 
		  ii.	 Enclose any direct quotes from other sources in quotation marks.
	 5.	� A Workbook is an Excel file that contains one or more worksheets. It is the overall file 

where all your data is stored. By default, a workbook starts with one worksheet, but you 
can add more as needed.

		�  A Worksheet is a single sheet within the workbook where you enter and manage data using 
rows and columns. It is the main working area in Excel and is also known as a spreadsheet.

	 6.	 To change the row height or column width in Excel, follow these steps:
		  i.	 Select the row(s) or column(s) you want to adjust.
		  ii.	 Click on the Format command in the Cells group under the Home tab.
		  iii.	 Under the Cell Size section, choose either Row Height or Column Width.
		  iv.	 Enter the desired value in the text box.
		  v.	 Click the OK button to apply the changes.
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 Database and DBMS—An Introduction

Tech Trivia Section A (Objective)

A.	 1.	 d	 2.	 c	 3.	 b	 4.	 c	 5.	 a
B.	 1.	 Navigation	 2.	 Datasheet	 3.	 Currency	 4.	 Title bar	 5.	 Lookup Wizard
C.	 1.	 F	 2.	 T	 3.	 T	 4.	 F

Answer Arcade Section B (Subjective)

A.	 1.	� A Database Management System (DBMS) is software that stores, retrieves, and manages 
data in a database. It allows efficient organisation and access to logically related data.

	 2.	 Short Text: Stores up to 255 characters; not used for calculations.
		  Long Text: Stores large amounts of text (up to ~1 GB); displays up to 64,000 characters.
B.	 1.	 There are mainly two types of databases:
		  i.	 Flat File Database:
			�   A flat file database is a simple type of database that stores data in a single table or file, 

often as plain text or in a spreadsheet format. Each record in the flat file is typically 
stored as a single line of text, with fields separated by a separator (like commas or tabs). 
The most popular example of a flat file database is Excel 2021.

		  ii.	 Relational Database:
			�   This type of database stores data in multiple tables and links these tables to retrieve 

related information. Commonly used relational database systems include Microsoft 
Access, Microsoft SQL Server, ORACLE, etc.

	 2.	� Primary Key: It is a unique field used to identify records uniquely within a table. A table 
can only have one primary key. It ensures that each record can be uniquely distinguished 
from others, preventing duplicate entries and maintaining data integrity. For instance, in 
a ‘Student’s record’, the ‘Reg No’ can be referred to as a primary key, as it is always unique 
and never null.

	 3.	 Access 2021 has the following components:
		  ●	� Quick Access Toolbar: It is a small bar at the top-left corner of the Access 2021 window. 

It usually has buttons for Save, Undo, and Redo, and it can be customised to include 
additional commands as needed.

		  ●	� Title Bar: It is the topmost bar of the Access window that displays the name of the 
currently opened database.

		  ●	� Ribbon: It is a long bar located below the Title Bar. It is divided into different tabs such 
as File, Home, Create, etc. These tabs are further divided into groups, which contain 
various commands of Access 2021.

7.
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		  ●	� Navigation Pane: This pane is located on the left side of the Access window. It displays 
the names of the objects used in the database, such as Table, Query, Form, etc. It allows 
users to easily access and manage the objects.

		  ●	� Navigation Buttons: These buttons help in navigating through the records.
		  ●	� Work Area: This is the area where users can add or modify records in different fields 

of a table.
		  ●	� Objects Tabs: The objects, such as Tables, Queries, and Forms, that are opened in the 

database appear as tabs under the Ribbon for easy access and switching between them.
		  ●	� Status Bar: It is located at the bottom-left corner of the Access window. It displays 

details about the database and current operations, such as record numbers and view 
status.

C.	 1.	� Create a table with fields for marks, use the Design View to add fields for Total and 
Percentage, and apply calculated fields using expressions for automatic calculations.

	 2.	� Use a Primary Key field, such as Product ID, to ensure each record is unique and prevent 
duplicate entries.

Higher Order Thinking Skills (HOTS)
	 1.	� Loss of data access can lead to work disruption and data loss. Use automatic backups and 

data recovery tools in DBMS to prevent such issues.
	 2.	� Yes, a database can detect anomalies using queries and reports to analyse data patterns, 

helping to identify unusual or fraudulent activities.

Code Clues

Locate eight terms related to operating systems in the following grid:
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Digital Drills

Do it yourself

 More on Access

Tech Trivia Section A (Objective)

A.	 1.	 c	 2.	 b	 3.	 d	 4.	 c
B.	 1.	 Primary Key			   2.	 Form Design
	 3.	 Modal Dialog			   4.	 Action Query
C.	 1.		  c
	 2.		  e
	 3.		  a
	 4.		  b
	 5.		  d
D.	 1.	 T	 2.	 F	 3.	 F	 4.	 F	 5.	 T

Answer Arcade Section B (Subjective)

A.	 1.	� Split Form shows two sections. The upper section shows a datasheet view with a list of 
records, while the lower section provides a detailed form for editing the selected record.

	 2.	� Select Query in Access retrieves data from one or more tables and displays the results in 
a datasheet view. It allows users to group data and perform calculations such as sums, 
counts, averages, and more.

	 3.	� A relationship between two tables connects them through a common field. The field in 
the first table is called the primary key, and the same field in the second table is called the 
foreign key.

B.	 1.	 The three main views in which a form can be displayed are: 
		  a.	 Form View is used to enter, edit, and view data. 
		  b.	� Design View is used to adjust the design of your form. It gives you a more detailed 

view of the structure of a form, such as a Header, Detail, and Footer sections. 
		  c.	� Layout View is used to change the appearance and size of various controls on a form. 

When you create a form, by default it appears in the Layout view.

8.
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	 2.	 The different types of queries in Access are: 
		�  Select Query: A query in Access retrieves data from one or more tables and displays the 

results in a datasheet view.
		  Parameter Query: It is a type of select query that prompts you for the input before it runs. 
		�  Action Query: It creates a new table or alters your data by adding, deleting, updating, and 

appending data from it. 
		�  Crosstab Query: It shows your data in a grid with row and column headings, so you can 

see and compare your information across two categories at once.
	 3.	 The two ways to format a form in MS Access are:
		  a.	� Using the Design Tab: You can add a logo and title to your form by making use of the 

Logo and Title commands present in the Header/Footer group under the Design tab.
		  b.	� Using the Format Tab: You can change the font, size, colour, and alignment of labels; add 

a background image to the form; change the colour of the shapes, etc. using various 
commands present on the Format tab.

C.	 1.	 A relationship between two tables connects them through a common field. 
	 	 To define the relationship between the two tables, follow the given steps:
	 	 Step 1: Click on the Database Tools tab.
	 	 Step 2:  Click on the Relationships command.
	 	 Step 3: Click on the Add Selected Tables button.
	 	 �Step 4: Drag and drop the Primary Key field of one table to the common field in the another 

table.
	 	 Step 5: Click on the Create button.
	 	 Benefit of creating a relationship is data redundancy is reduced.
	 2.	 To manage a school library system database efficiently, you can use Forms, Queries, Reports. 
	 	 �Forms: By creating forms, you can make your database more user-friendly for those who 

edit and enter the records.
	 	 �Query: Using a query, you can search for data from one or more tables by giving specific 

search conditions. By using a query you are able to view the exact data that you want.
	 	 �Reports: Allows you to organise and present your data in a user-friendly format so that it 

can be printed.
	 	� By using these features, you can maintain a well-organised, interactive, and efficient library 

management system in Microsoft Access.

Higher Order Thinking Skills (HOTS)
	� 1.	� Forms provide a clean and structured layout, making it easier for users to enter, view, or 

edit data.You can control what fields appear. Instead of scrolling through huge tables, users 
can focus only on relevant fields, which improves efficiency.You can design custom forms 
for better data clarity and management.

	 2.	 Do it yourself.
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Code Clues

Locate eight terms related to Access in the following grid: 

Digital Drills

Do it yourself

 Lists and Tables in HTML

Tech Trivia Section A (Objective)

A.	 1.	 c	 2.	 d	 3.	 a	 4.	 b	 5.	 c
B.	 1.	 START	 2.	 Columns	 3.	 Table Heading			   4.	 TYPE
	 5.	 Width
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 T

9.
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Answer Arcade Section B (Subjective)

A.	 1.	� A nested list is a list within another list. An ordered list can be nested inside an unordered 
list and vice versa.

	 2.	 Use the CSS background-color property to apply background colour to a table.
B.	 1.	� There are three types of lists named ordered list, unordered list and definition list that can 

be created in HTML5 to display the items in the form of list.
		  a.	 Ordered List: This type of list is used to display the items in a sequential manner. 
			   For example, steps in an algorithm
		  b.	� Unordered List: This type of list is generally used to display random items that are never 

required to be placed in a sequential manner. Example:
			   <ul>

			     <li>Apple</li>

			     <li>Banana</li>

			     <li>Cherry</li>

			   </ul>

		  c.	� Definition List: The definition list is also known as a description list. The description list 
is created by using the <DL> tag in conjunction with <DD> and <DT> tags. The <DL> 
tag defines the entire description list. The <DT> tag defines the description term. The 
<DD> tag defines the description term’s definition. Example: 

			   <dl>

			     <dt>HTML</dt>

			     �<dd>A markup language used to structure content on the web.</
dd>

			     <dt>CSS</dt>

			     �<dd>A stylesheet language used to style the appearance of web 
pages.</dd>

			   </dl>

	 2.	� CSS provides various properties that can be used with <TABLE> tag to accomplish 
various tasks. They are border, border-style, border-color, border-spacing, width, padding, 
background-color and color.

		  Example: <style>
		    table, th, td {

		      border:2px;

		      border-style:solid;

		      border-color:green;

		      border-spacing:10px;

		      padding:15px;



TrackGPT iPro (5.0)-VII (Answer Key)22

		      background-color:orange;

		      color: blue;

		    }

		  </style>

	 3.	� Following are the attributes of <TD> tag used to present the cell or table data in more 
effective manner: 

		�  ROWSPAN: The ROWSPAN attribute applies when a cell is extended for more than one 
row, that is, the cell spans for 2 or more rows instead of 1. 

		�  COLSPAN: The COLSPAN attribute applies when a cell is extended to more than one column, 
that is, the cell spans for 2 or more columns instead of 1.

C.	 1.	 To display categories like Electronics, Books, Clothing using an unordered list:
		  <!DOCTYPE html>

		  <html>

		  <head><title>Online Store</title></head>

		  <body>

		    <h2>Store Categories</h2>

		    <ul>

		      <li>Electronics</li>

		      <li>Books</li>

		      <li>Clothing</li>

		    </ul>

		  </body>

		  </html>

	 2.	 To create a student results table with Roll Number, Name, Grade, the key tags are:
	 	 <table>: Creates the table.
	 	 <tr>: Defines a table row.
	 	 <th>: Defines a table header.
	 	 <td>: Defines table data.

Higher Order Thinking Skills (HOTS)
	 1.	� The list feature of HTML5 allows us to display information on the web page in an  organised 

manner, whereas tables represent the data in the form of rows and columns.
	 2.	 Do it yourself.
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Code Clues

Guess! Who am I? 
	 a.	 background-color
	 b.	 Ordered List (<ol>)
	 c.	 <li>
	 d.	 Disc
	 e.	 padding

Digital Drills

Do it yourself

    More on HTML

Tech Trivia Section A (Objective)

A.	 1.	 a	 2.	 c	 3.	 b	 4.	 c	 5.	 d
	 6.	 b	 7.	 b
B.	 1.	 Autoplay	 2.	 Website	 3.	 Hypertext reference	 4.	 Frames
	 5.	 Anchor tag
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 T

Answer Arcade Section B (Subjective)

A.	 1.	� The <SELECT> tag is used to add a drop-down list in the HTML form. This tag produces 
a list of options for the user with the help of <OPTION> tag. We can create a combo box 
using <SELECT> and <OPTION> tags.

	 2.	� Intralinking allows users to navigate to different parts of the same page quickly and easily 
by clicking on hyperlinks that lead to other sections or elements on the page.

	 3.	 Opens the linked web page in a parent window or tab of the web browser.
	 4.	� A checkbox control allows us to select multiple options from a set of options.
		  To add the check box in the form, follow the syntax as given below: 
		�  <INPUT TYPE=”CHECKBOX” NAME=”Name of check box” VALUE=”value of 

check box”>

10.
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B.	 1.	� The <TEXTAREA> tag is used to create a multi-line text input area that can accept long 
text values. We can specify the number of rows and columns we want in text area by using 
the ROWS and COLS attributes of the <TEXTAREA> tag. 

		  The syntax of the <TEXTAREA> tag is as follows: 
		  <TEXTAREA ROWS=”2” COLS=”70”>

	 2.	 To add the password field to the form, follow the syntax as given below: 
		�  <INPUT TYPE=”PASSWORD” NAME=”Name of Password Field” SIZE=”Size of 

the password Field”>

	 3.	� Web pages are linked with the help of a feature of HTML called a hyperlink. A hyperlink 
is generally an underlined text that takes the user to another web page when clicked. 
Generally, hyperlinks are seen in blue colour. Images can also be used as hyperlinks. When 
the mouse is hovered over a hyperlink, the mouse pointer changes to a hand shape. When 
a hyperlink is clicked, its colour changes to purple. The syntax to create a hyperlink is: 

		  <A HREF = “URL of Web Page” TARGET=”_blank”> Link Text </A>

	 4.	� Intralinking: The process of linking specific sections or elements within the same web page 
or website. It allows users to navigate to different parts of the same page quickly and easily 
by clicking on hyperlinks that lead to other sections or elements on the page. 

		�  Interlinking: The process of linking one web page to another web page, either within the 
same website or to a different website. It involves creating hyperlinks that connect different 
web page, facilitating navigation between related content and enhancing the website’s 
overall connectivity.

	 5.	� HTML also allows us to insert images inside the web pages through the <IMG> tag. The 
<IMG> tag is an empty tag and has various attributes. 

		  The attributes of the <IMG> tag are: 
		  Src: It specifies the source location or URL of the image to be inserted in the web page. 
		  Width: It specifies the width of the image on the web page. 
		  Height: It specifies the height of the image on the web page. 
		�  Alt: It specifies the alternate text to be displayed in the web browser, if the provided image 

is not found. 
C.	  1.	� To ensure that users with slow internet or visual impairments can understand the content 

of the image, use the alt (alternative text) attribute in the <img> tag.
	 2.	� You can create a form using the <form> tag along with various <input> fields to collect 

user information like name, email, gender, and more.

Higher Order Thinking Skills (HOTS)
	 1.	� Using the target="_blank" attribute incorrectly in hyperlinks can lead to several security, 

usability, and accessibility issues on a webpage.
	 2.	 Do it yourself.
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Code Clues

Identify and label the parts of the Excel window accurately.
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Digital Drills

Do it yourself

Worksheet 2
(Based on chapters 7 to 10)

A.	 1.	� DBMS - A Database Management System (DBMS) is software that stores, retrieves, and 
manages data in a database. It allows efficient organisation and access to logically related 
data.

	 2.	� Datasheet View - Datasheet view is the default view of the table. It shows all the fields and 
the records as entered by the user. In this view, you can edit the records of the table.

	 3.	� Query - A query is the most powerful object for retrieving information from a table based 
on specific criteria or conditions. It allows you to find and extract data from the database 
by creating and running the query.

	 4.	� Forms in HTML - are used to collect user input. They include elements like text boxes, 
checkboxes, radio buttons, and drop-down menus.

	 5.	� Ordered list - An ordered list is also called the numbered list. This type of list is used to 
display the items in a sequential manner. For example, steps in an algorithm, etc. In HTML, 
the <OL> tag is used to create an ordered list.
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	 6.	 �Interlinking: The process of linking one web page to another web page, either within the 
same website or to a different website. It involves creating hyperlinks that connect different 
web page, facilitating navigation between related content and enhancing the website’s 
overall connectivity.

B.	 1.	 Microsoft SQL Server, ORACLE
	 2.	 Title Bar, Ribbon
	 3.	 Number, Date/Time
	 4.	 Select Query, Action Query
	 5.	 START, TYPE
	 6.	 Autoplay, Control
	 7.	 background-color
	 8.	 a:active
	 9.	 type
	 10.	 <textarea>
C.	 1.	 TYPE=”RADIO”
	 2.	 TYPE=”SUBMIT” 
	 	 TYPE=”RESET”
	 3.	 <SELECT> tag with the <OPTION>

Test Sheet 1
(Based on chapters 1 to 6)

Section A
A.	 1.	 a	 2.	 c	 3.	 a	 4.	 c	 5.	 b
	 6.	 a	 7.	 c	 8.	 c
B.	 1.	 F	 2.	 T	 3.	 T	 4.	 F	 5.	 F	 6.	 T
C.	 1.	 Form view	 2.	 Relationship			   3.	 Run	 4.	 ordered list
	 5.	 <a>	 6.	 <select>

Section B
A.	 1.	� A relationship between two tables connects them through a common field. The field in 

the first table is called the primary key.
	 2.	� Yes, you can add an image as a background in a form in Microsoft Access using the Format 

Tab.
	 3.	 <CAPTION> tag is used for defining the title of the table.
	 4.	� The BORDER attribute in the <IMG> tag is used to specify the width of the border around 

an image on a web page.
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B.	 1.	 Advantages of the Database Management System are:
	 	 a.	 �Keeps Data Accurate: DBMS helps ensure that the information stored is correct, reducing 

mistakes. 
	 	 b.	 Fast Data Access: It makes finding and retrieving information quick and easy. 
	 	 c.	 �Protects Information: DBMS lets you control who can see or change the data, keeping 

it safe. 
	 	 d.	 �Allows Sharing: Many people can use the same data at the same time without any 

issues. 
	 	 e.	 �Automatic Backups: It saves copies of the data and can restore it if something goes 

wrong.
	 2.	� A form is a database object used to add, edit, and display data from a table in a user-

friendly manner. While creating a form, you can choose the fields to be displayed and how 
they are displayed. By creating forms, you can make your database more user-friendly 
for those who edit and enter the records. The three main views in which a form can be 
displayed are Form View, Design View and Layout View.

	 3.	 <!DOCTYPE html>

		  <html>

		  <head>

		      <title>Student Marks Table</title>

		  </head>

		  <body>

		      �<table border=”1” cellpadding=”8” cellspacing=”0” style=”border-
collapse: collapse; text-align: center;”>

		          <tr>

		              <th rowspan=”2”>Name</th>

		              <th rowspan=”2”>Subject</th>

		              <th colspan=”2”>Marks</th>

		          </tr>

		          <tr>

		              <th>Term 1</th>

		              <th>Term 2</th>

		          </tr>

		          <tr>

		              <td>Chirag</td>

		              <td>English</td>

		              <td>79</td>

		              <td>87</td>

		          </tr>

		          <tr>

		              <td>Divya</td>
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		              <td>Math</td>

		              <td>88</td>

		              <td>83</td>

		          </tr>

		      </table>

		  </body>

		  </html>

	 4.	 The <INPUT> tag has the following attributes: 
	 	 NAME: This attribute is used to specify the identity of the field on the web page. 
	 	 �TYPE: This attribute is used to specify the type of field we want to create. It takes one of 

the predefined values. 
		  Login form to accept user name and password from the user
	 	 <!DOCTYPE html>

		  <HTML>

		  <BODY>

		  <FORM>

		�  USER NAME: <INPUT TYPE=”TEXT” NAME=”EName1” SIZE=”30” VALUE=”Enter 
User Name”>

		  Password: <INPUT TYPE=”PASSWORD” NAME=”Pass” SIZE=”10”>

		  </FORM>

		  </BODY>

		  </HTML>


